## Table of Contents

1 Welcome ................................................................................................................................. 1

2 Introduction ............................................................................................................................. 2
   1 System requirements ........................................................................................................... 2
   2 Using PicoDiagnostics for the first time ........................................................................... 2
   3 Licence agreement ............................................................................................................ 3

3 Menus ..................................................................................................................................... 4
   1 File menu ........................................................................................................................... 4
   2 View menu ......................................................................................................................... 5
       1 Customer details dialog .............................................................................................. 6
   3 Tests menu ......................................................................................................................... 8
   4 Options menu ..................................................................................................................... 8
   5 Help menu ........................................................................................................................ 8

4 Tests ....................................................................................................................................... 9
   1 Cylinder balance ............................................................................................................... 9
       1 Introduction ................................................................................................................ 9
       2 Test conditions .......................................................................................................... 9
       3 Wizard ....................................................................................................................... 10
       4 Options ..................................................................................................................... 11
       5 Running the test ......................................................................................................... 11
       6 Controls ..................................................................................................................... 12
       7 Signal graph ............................................................................................................. 13
       8 Failed test ................................................................................................................ 14
   2 Compression test ............................................................................................................. 15
       1 Introduction ............................................................................................................. 15
       2 Test conditions ........................................................................................................ 15
       3 Connections .......................................................................................................... 16
       4 Test setup ............................................................................................................... 16
       5 Options .................................................................................................................... 16
       6 Running the test ..................................................................................................... 17
       7 Failed test ............................................................................................................. 19
   3 Battery test ....................................................................................................................... 20
       1 Introduction ............................................................................................................ 20
       2 Connections ............................................................................................................ 21
       3 Setup ..................................................................................................................... 22
       4 Options ................................................................................................................... 23
       5 Running the test ................................................................................................... 24
       6 Interpreting the results ........................................................................................... 25
   4 Propshaft balancing ......................................................................................................... 26
       1 Preparing the vehicle ............................................................................................... 26
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>2 Running PicoDiagnostics</td>
<td>26</td>
</tr>
<tr>
<td>3 Options</td>
<td>39</td>
</tr>
<tr>
<td>5 NVH</td>
<td>40</td>
</tr>
<tr>
<td>1 Equipment</td>
<td>40</td>
</tr>
<tr>
<td>2 Terminology</td>
<td>40</td>
</tr>
<tr>
<td>3 Connecting the PicoScope and sensor</td>
<td>41</td>
</tr>
<tr>
<td>4 Running the PicoDiagnostics software</td>
<td>41</td>
</tr>
<tr>
<td>5 Selecting the NVH test</td>
<td>41</td>
</tr>
<tr>
<td>6 NVH Wizard</td>
<td>42</td>
</tr>
<tr>
<td>7 NVH Setup page</td>
<td>43</td>
</tr>
<tr>
<td>8 NVH Vehicle Information page</td>
<td>48</td>
</tr>
<tr>
<td>9 NVH Record and Analyze page</td>
<td>51</td>
</tr>
<tr>
<td>10 Viewing the results</td>
<td>51</td>
</tr>
<tr>
<td>11 NVH Options</td>
<td>63</td>
</tr>
<tr>
<td>12 NVH Advanced Options</td>
<td>64</td>
</tr>
<tr>
<td>13 Load Audio dialog</td>
<td>67</td>
</tr>
<tr>
<td>14 Function Generator</td>
<td>68</td>
</tr>
<tr>
<td>Index</td>
<td>71</td>
</tr>
</tbody>
</table>
1 Welcome

Welcome to **PicoDiagnostics**, the automotive fault-finding software for your PicoScope Oscilloscope.

With a PicoScope, **PicoDiagnostics** turns your PC into an automotive diagnostics tool. The program includes a range of built-in tests that are easy to operate, even if you haven't used them before.

If you need to go beyond the built-in tests, an additional program is available: **PicoScope Automotive**. This software will have been downloaded and installed along with PicoDiagnostics. This gives you all the features of an advanced oscilloscope and can be used to diagnose almost any electrical component in any vehicle.
2 Introduction

PicoDiagnostics supports the PicoScope 3000 Automotive and 4000 Automotive Series diagnostic oscilloscopes.

How to use PicoDiagnostics
- Getting started: see Using PicoDiagnostics for the first time.
- For further information: see descriptions of Menus.

2.1 System requirements

PicoDiagnostics software: runs on a PC or laptop running a Windows 7 and later* operating system.

*Earlier versions of PicoDiagnostics remain compatible with Windows XP SP3, Windows Vista SP2.

2.2 Using PicoDiagnostics for the first time

We have designed PicoDiagnostics to be as easy as possible to use, even for newcomers to automotive diagnostics. Once you have followed the introductory steps listed below, we hope that you will soon become an expert.

1. Plug in your PicoScope oscilloscope. Windows will recognise it and make the necessary changes to allow your computer to work with it. Wait until Windows tells you that the device is ready to use.

2. Click the new PicoDiagnostics icon on your Windows desktop.

3. Click the button for the test you wish to perform.

4. Follow the on-screen Setup Wizards or instructions on connecting your scope and running the test.
2.3 Licence agreement

The material contained in this release is licensed, not sold. Pico Technology grants a licence to the person who installs this software, subject to the conditions listed below.

**Access.** The licensee agrees to allow access to this software only to persons who have been informed of these conditions and agree to abide by them.

**Usage.** The software in this release is for use only with Pico products or with data collected using Pico products.

**Copyright.** Pico Technology claims the copyright of, and retains the rights to, all material (software, documents etc.) contained in this release. You may copy and distribute the entire release in its original state, but must not copy individual items within the release other than for backup purposes.

**Liability.** Pico Technology and its agents shall not be liable for any loss, damage or injury, howsoever caused, related to the use of Pico Technology equipment or software, unless excluded by statute.

**Fitness for purpose.** No two applications are the same: Pico Technology cannot guarantee that its equipment or software is suitable for a given application. It is your responsibility, therefore, to ensure that the product is suitable for your application.

**Mission-critical applications.** This software is intended for use on a computer that may be running other software products. For this reason, one of the conditions of the licence is that it excludes usage in mission-critical applications, for example life-support systems.

**Viruses.** This software was continuously monitored for viruses during production, but you are responsible for virus-checking the software once it is installed.

**Support.** If you are dissatisfied with the performance of this software, please contact our technical support staff, who will try to fix the problem within a reasonable time. If you are still dissatisfied, please return the product and software to your supplier within 14 days of purchase for a full refund.

**Upgrades.** We provide upgrades, free of charge, from our website at [www.picotech.com](http://www.picotech.com). We reserve the right to charge for updates or replacements sent out on physical media.

**Trademarks.** *Windows* is a registered trademark of Microsoft Corporation. *Pico Technology, PicoScope and PicoDiagnostics* are internationally registered trade marks.
3 Menus

Menus are the quickest way to get to the main features in PicoDiagnostics. The Menu bar is always present at the top of the PicoDiagnostics main window, just below the window’s title bar. You can click any of the menu items, or press the Alt key and then navigate to the menu using the cursor keys, or press the Alt key followed by the underlined letter in one of the menu items.

File View Tests Options Help

The list of items in the menu bar may vary depending on which test you are running.

3.1 File menu
Click File on the Menu bar.

Load... Allows you to load a test from disk to review the result. Loading a test result from disk will clear any captured data and results.

Save. Some tests allow you to save test data to disk.

Print. Opens a standard Windows print dialog, which allows you to choose a printer, set printing options and then print the selected view.

Print Preview. Opens the Print Preview window, which allows you to preview the report before printing it with the Print command.

Preferences. Opens up the User Details dialog.

Exit. Close PicoDiagnostics without saving any data.
3.1.1 User Details dialog

This dialog appears when you select **Preferences** on the **File menu**. It allows you to enter details about your company and your name. These will appear on the report.

![User Details dialog](image)

**How to use the dialog**

Enter all the values you want. Click **OK** to close the dialog and save the changes. Click **Cancel** to close the dialog and discard the changes.

**The items in the dialog**

- **Company**: The name of your company. This will be displayed on the report if no logo has been selected.
- **Name**: Name of the technician, or the contact name, to appear on the report.
- **Telephone**: The contact number that the customer will see on the report.
- **Address**: The address of your company. There is space for four lines.
- **Logo**: Your company logo (selecting a file here will enable it to appear on your reports).

3.2 View menu

Click **View** on the **Menu bar**.

![View menu](image)

**Details**. Edit the **customer and vehicle details and notes**.
3.2.1 Customer details dialog
This dialog appears when you select **Details** on the **View menu**. It allows you to enter details about the customer and the vehicle you are testing. There is also a space for entering notes about the test.

How to use the dialog
This dialog is for you to store data about the customer and the vehicle that the test applies to. The data in this dialog will be saved with the test and printed on the report.

Click **OK** to close the dialog and save the changes.

Click **Cancel** to close the dialog and discard the changes.
Customer details

Name. The customer’s name.

Phone. The customer's phone number.

Address. The customer's address. There is space for 4 lines.

Vehicle details

Make. The make of the vehicle. The makes of vehicles are stored in a database. If you manually enter a make which is not already saved, a message box will pop up.

Model. The model of the vehicle. When a make has been selected, this list is populated with all the currently known models of that make.

Year. The year of the vehicle.

ID. An identification number for the vehicle. Can be the VIN or anything else you choose.

Notes

In the Notes field you can enter additional information that you want stored with the test.
3.3 Tests menu
Click **Tests** on the **Menu bar**.

This menu lists all the tests available. Click one of the tests to proceed.

3.4 Options menu
The **Options** menu changes depending upon which test you are carrying out at the time. Please see below for links to the test options you require:

- Cylinder balance options
- Compression test options
- Battery test options
- NVH test options
- Propshaft balancing options

3.5 Help menu
Click **Help** on the **Menu bar**.

These are the standard Windows options for access to this help file.

Note: *Show Vibrate Help* option only appears when within the NVH test.
4 Tests

PicoDiagnostics is a collection of specific automotive tests. They are all designed to be easy to use, even if you have little or no experience of automotive diagnostics.

To begin any test, click the PicoDiagnostics icon on your computer:

These tests are available with this installation of PicoDiagnostics:

- Cylinder Balance
- Compression Test
- Battery Test
- NVH
- Propshaft Balancing

4.1 Cylinder balance

4.1.1 Introduction

The cylinder balance test measures how much each cylinder contributes to the engine's total power output. There are a number of things that can cause a cylinder to contribute less than the other cylinders. These include but are not limited to:

- low compression
- faulty injector
- faulty spark plug.

A slightly uneven balance does not necessarily mean that there is a fault in the engine. During warm-up, most engines run slightly unevenly. Deposits and engine wear may also have an effect on the engine's performance.

To use the cylinder balance, start PicoDiagnostics and set the test conditions.

4.1.2 Test conditions

The following test conditions must be met before running the test:

- The engine must be at normal running temperature. This can be confirmed when the cooling fan has activated twice, and by referencing the temperature gauge on the vehicle's dashboard.
- The engine must be off before connecting the oscilloscope.

If this is the first cylinder balance test you are running, load the test using the Tests menu. Follow the on-screen wizard instructions to connect your PicoScope to the vehicle. If however you have already run a cylinder balance test, simply click Setup and follow the on-screen wizard instructions.
4.1.3 Wizard

The cylinder balance setup wizard consists of 4 screens.

Screen 1: Contains a notice about using the software.

Screen 2: Gives you guidance on connecting the PicoScope ready for the Cylinder Balance test.

**Connect the oscilloscope**

Connect the scope to a USB port on your PC using the USB cable.

Connect one of the general test BNC cables to Channel A on your oscilloscope. On the other end, connect a large red crocodile clip to the red cable and a large black crocodile clip to the black cable. Connect the red clip to the battery positive (+) and the black clip to the battery negative (−) as shown in the picture above.

Screen 3: Lets you specify how many cylinders the vehicle to be tested.

Screen 4: Shows the signal strength between the PicoScope and the vehicle to be tested.

**Note:** If the signal strength is low you can improve it by switching on various ancillaries such as mainbeam lights, fog lights, interior fan (full), rear demister.
4.1.4 Options
This dialog appears when you click the Options menu on the main Menu bar while the Cylinder Balance Test is selected. It allows you to set whether the Cylinder balance wizard appears before running the test.

4.1.5 Running the test
To start the test click Start. If the test successfully starts, a new window with a progress indicator will briefly appear on the screen. The data is now being analysed and shown in real time on screen with the results appearing in the bar graph as shown below.

The result
If the test could not produce a result see: Failed cylinder balance.

You can stop the test at any time by simply clicking Stop. It is possible to then scan through the results by clicking Play. The results are always scaled to show the highest cylinder at 100%.

Controls
During the test you can right-click on the bar graph to get a control menu. See: Cylinder balance controls.
4.1.6 Controls

Right-click the cylinder balance bar graph to bring up a menu with display options. You can use this menu to access more information concerning the test and its result.

<table>
<thead>
<tr>
<th>Variation</th>
<th>Misfire</th>
<th>Signal</th>
</tr>
</thead>
</table>

**Variation**
Displays the variation in contribution for each cylinder as an overlaid blue bar.

**Misfire**
Displays suspected misfires as a separate bar for each cylinder.

**Signal**
*Not required for basic testing*

Brings up a second graph, the **signal graph**, that can display the engine speed or the contribution for each cylinder over time. To zoom in on the data, click and drag to select the range to display.
4.1.7 Signal graph

The signal graph displays the captured data as engine speed or cylinder contribution.

**Zooming**

You can use the mouse to zoom in on the data. Use the context menu (right-click) to zoom out again.

**Signal graph context menu**

Right-click the graph to bring up a menu with display options. You can use this menu to access more information concerning the test and its result.

- **Zoom Out**
- **View**
  - Engine Speed
  - Cylinder Contribution
  - Trigger Signal with Speed Signal

**Zoom out**

This zooms out to display the full dataset.

**View**

You can choose to view the engine speed, the cylinder contribution, or view the Trigger Signal with Speed Signal.
Failed test

If the test could not produce a result, make sure that:

- the connection to the battery is good
- the tension of the alternator belt is adequate.

It may also help if you switch the headlights on full beam and switch on other electrical loads, such as the rear windscreen heater and fog lights.

There are some engines for which the test has difficulties producing a result. These include:

- engines with more than 8 cylinders
- some engines with dual mass flywheels
- engines with inertial dampers
- some engines with smart alternators
- vehicles with xenon lights

If there is still a problem

If you have checked the points mentioned above and the software still cannot produce a result, we would like you to send us a copy of the of the failed test data. Please enter as much information as possible about the vehicle tested. This is done via the Details dialog. Save the test to a file using the File > Save menu and email the file to us on picodiagnostics.feedback@picotech.com.
4.2 Compression test

4.2.1 Introduction

The compression test is meant to be a first check. If the compression looks good, you can quickly move on and investigate other components which might be the cause of the fault. If the test detects a low cylinder, you should perform a manual compression test to verify the results and to work out which cylinder is low.

To use the compression test, start PicoDiagnostics and click Compression Test.

There are two types of compression test:

- **Relative compression** - requires no pressure transducer, only a connection to the battery.
- **Absolute compression** - requires a connection to the battery and a pressure transducer connected to a spark plug port.

Follow the instructions below to connect your PicoScope to the vehicle and run the test:

- **Set the test conditions**
- **Connect the oscilloscope**
- **Connect the pressure transducer** (only for the absolute compression test)
- **Disable the engine**
- **Run the test**
- **If the result is blank**

4.2.2 Test conditions

The following test conditions must be met before running the test:

- The engine must be at normal running temperature, which is indicated by the cooling fan switching on.
- The engine must be off before connecting the oscilloscope.
- The cranking speed must be normal (battery must be charged).
4.2.3 Connections

**Connecting the oscilloscope**
Connect the oscilloscope to a free USB port on your PC using the USB cable.

Connect one of the general test BNC cables to Channel A on your scope. On the other end, connect a large red crocodile clip to the red lead and a large black crocodile clip to the black lead. Connect the red clip to the battery positive (+) and the black clip to the battery negative (—).

**Connecting the pressure transducer (absolute compression test only)**
Remove the spark plug from any convenient cylinder. Fit a compression hose into the empty spark plug socket, then attach it to the pressure transducer's inlet port, as shown in the picture below. Then connect a BNC to BNC cable from the pressure transducer to Channel B on your scope.

![Image of a compression test setup](image)

**Disabling the engine**
The compression test can only be performed when the engine is cranking, so it must be prevented from starting. This can be done by removing the engine management relay from the fuse box or disabling the injectors.

4.2.4 Test setup
The compression test should be performed according to the vehicle manufacturer's specification.

- If you are using the pressure transducer, click **Pressure**.
- Next, click the numbered button corresponding to the number of cylinders in the engine.

4.2.5 Options
This dialog appears when you click either the **Options** menu on the main menu bar while the **Compression Test** is selected, or the **Pressure** button, located at the bottom of the screen. It allows you to set special options before running the test. These options apply only to the absolute compression test, and not to the relative compression test.
Compensate: Check to use the Cylinder Volume, Compression Ratio and Sensor Volume parameters. Leave unchecked to ignore these values.

Cylinder Volume (l): The volume of the cylinder in litres.

Compression Ratio (X:1): The compression ratio of the cylinder. For example, if the compression ratio is 11:1, enter 11.

Sensor Volume (l): The volume of the pressure sensor in litres. This information should be available from the manufacturer of the sensor. If in doubt, do not alter the value in this box.

Engine Capacity: The size in CC of the engine under test.

Use Pressure Sensor: Indicates whether a WPS500X pressure transducer is being used during the test.

4.2.6 Running the test

- To start the test, click **Start**.
- A new window with a progress indicator and instructions will appear on the screen. Wait until the message in the window is "Crank engine".
- With the throttle wide open (accelerator pedal fully pressed), crank the engine until the progress indicator reaches 100%.

The data is now analyzed and the result appears in a bar graph, as in one of the examples below:
In relative compression mode, the result is always scaled to show the highest cylinder at 100%. The bars are ordered according to the engine's firing order. The cylinders are named A, B, C and so on, because with only a connection to the battery the software has no way of knowing which cylinder is number one. This may cause the result to be shifted if you run the test on the same engine more than once.

In absolute compression mode, PicoDiagnostics shows the true compression in each cylinder. As in relative compression mode, the bars are named A, B, C and so on.

The result
If the test could not produce a result, see Failed compression test.
4.2.7 Failed test

If the test could not produce a result, make sure that:

- the connection to the battery is good
- there is not a battery charger connected to the vehicle's electrical system.

If there is still a problem

If you have checked the points mentioned above and the software still can't produce a result, we would like you to send us a copy of the of the failed test data. Please enter as much information as possible about the vehicle tested. This is done using the Details dialog. Save the test to a file using the File | Save menu and email the file to us at support@picotech.com.

Note: Some engines fitted with a flat-plane crank can give spurious low compression readings.
4.3 Battery test

4.3.1 Introduction
To use the battery test, start PicoDiagnostics and click Battery Test.

**Tip:** If the battery has been recently charged, there is a risk of “surface charge” affecting the state-of-charge results. To eliminate the surface charge, switch the lights on full beam for about 2 minutes and then wait for about 2 minutes before performing the test. If you are only measuring cold cranking amps then you can ignore this precaution.

Follow the instructions below to connect your PicoScope to the vehicle and run the test.

- Connect the PicoScope
- Set any special test options
- Run the test
- **If the result is blank**
4.3.2 Connections

**Connect the PicoScope**
Connect the PicoScope to a free USB port on your PC using the USB cable.

**Channel A: Battery voltage**
Connect one of the general test BNC cables to Channel A on your PicoScope. On the other end, connect a large red crocodile clip to the red lead and a large black crocodile clip to the black lead. Connect the red clip to the battery positive either on the battery or in the fuse box. Connect the black clip to a secure earth (ground) point as shown in the picture below.

**Channel B: Starter motor current**
Connect the 2000 A or 600 A current clamp to Channel B on the PicoScope. Place the current clamp so that it is positioned around the positive cables which are connected to the positive battery terminal. More importantly make sure the current clamp is positioned around the starter motor positive or negative cable in order to record the cranking current from the starter.

If you have a 4-channel scope then you can run the optional extended drop test.

**Additional connections for extended drop test**

In addition to connecting channels A and B as described above, Channels C and D must also be connected as follows:

**Channel C: Starter motor positive terminal**
Using a BNC to 4 mm lead, connect the red 4 mm plug to the positive terminal of the starter motor using the appropriate clip / connector. This is the terminal that the main positive cable from the battery connects to.

**Channel D: Starter motor negative terminal**
Using a BNC to 4 mm lead, connect the red 4 mm plug to the negative terminal of the starter motor using the appropriate clip / connector.

Note: Most modern vehicles don’t have earth cables to the starter motor. In this case connect to one of the mounting bolts by which the starter motor is attached to the engine or gearbox bell housing, as the starter will earth through to chassis and/or battery.

This will enable PicoDiagnostics to separate the cable resistance from the starter motor resistance.

All connections must be clean and free from oil, grease and dirt to ensure the readings are accurate.
Setup

First, click either **12 V** or **24 V** depending on the voltage of your electrical system.

**Tip:** If you have a **24 V** system with two 12 V batteries, test each battery separately. Otherwise one good battery could hide a fault in the other battery.

Next, set the **type** of battery to match the battery you wish to test.

Set the **Temperature** to the local air temperature in °C or °F depending on preferences.

The battery capacity in cold cranking amperes (**CCA**) should now be entered, along with its standard (**CCA Unit**).

Now, set the battery test options (see **Battery test options**).
4.3.4 Options

This dialog appears when you click the **Options** menu on the main menu bar while the **Battery Test** is selected. Here you can:

- Enable the **Extended drop test** options
- Adjust the capture time of the test

![](image)

- Click **OK** to confirm
4.3.5 Running the test
Click **Start**.

*Note: Because the engine is not drawing any current at this stage, the program will draw a horizontal line showing zero amps of current. If this line is not at zero amps, the current clamp may need to be adjusted. Press the "Zero" button or turn the "Zero" dial on the clamp until the horizontal line is at zero amps.*

Start the engine.

While the test is running, the program shows the voltage on **Channel A** and the current on **Channel B**, and a graph is drawn from left to right. The program automatically stops recording data when it has enough information, so there is no need to click the **Stop** button unless you wish to stop the test early.

The program then analyses the data and shows the results in a table, as in the picture below:

If the program reports "Battery has failed the test - refer to help file for advice", see **Interpreting the Results**.
4.3.6 Interpreting the results

If the state of charge is low then recharge the battery and re-test.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>Initial voltage</td>
<td>12.6V</td>
<td></td>
</tr>
<tr>
<td>State of Charge</td>
<td>Bad cell</td>
<td>Check connections and idle current</td>
</tr>
<tr>
<td>Lowest voltage</td>
<td>91.1 mV</td>
<td></td>
</tr>
<tr>
<td>Voltage drop</td>
<td>12.6 V</td>
<td></td>
</tr>
<tr>
<td>Maximum current</td>
<td>56.3 A</td>
<td></td>
</tr>
<tr>
<td>Internal resistance</td>
<td>-1580</td>
<td>Invalid</td>
</tr>
<tr>
<td>Capacity @ 20°C</td>
<td>0 CCA</td>
<td>Capacity is 0% of 700 CCA</td>
</tr>
<tr>
<td>Condition</td>
<td>Replace</td>
<td>Battery has failed</td>
</tr>
</tbody>
</table>

If the state of charge is all right but the CCA (cold cranking amps) is low then check these things before replacing the battery:

- Check the battery connections. If they are loose, they could increase the internal resistance.
- If the battery is not a sealed type, check the fluid levels in each cell.
4.4 Propshaft balancing

The propshaft needs to be balanced after removing one or more components of the transmission system. This is done using the PicoDiagnostics Propshaft Balancing program, by fitting balancing weights on the differential coupling flange, using off-the-shelf hose clamps on the propshaft, or attaching a single balancing weight to the propshaft.

4.4.1 Preparing the vehicle

Raise and support the vehicle according to manufacturer directions. Remove the two rear wheels and secure the rotors or drums to the hub assembly. Position the vehicle on mounts in order to hold the vehicle level and at the same height as if the wheels were fitted.

Remove any balancing weights from the flange stud bolts before starting the balancing procedure.

4.4.2 Running PicoDiagnostics

The propshaft balancing procedure is divided into four stages:

- Initial Run
- Calibration Runs
- Verification
- Free run

Click **Balancing:**

Click which format you would like to use to complete the propshaft balancing test.
The program displays step-by-step instructions in the form of a Wizard for both formats of this test. We recommend that you follow your chosen procedure carefully.

4.4.2.1 Pinion Flange Trial Balance Wizard

The Pinion Flange test wizard will run you through the various steps required to complete your test. These will steps will cover:

- Connections to the scope
- Mounting the accelerometer to the vehicle
- Fit the magnetic mount and optical sensor (if required) in order to read the propshaft rotation speed
- Entry of required technical data

4.4.2.1.1 Initial Run

**Before you begin**

- Insure the vehicle is properly supported (refer to service information)
- Remove rocks and debris from the tires
- Ensure all the leads are clear of rotating components
- Disable ABS and Traction control if equipped
- Turn off the AC and other accessories

Find a suitable shaft speed. Run the engine with the transmission in high gear to highway speed (65-70 mph or 105-113 km/h typical). The software will capture the RPM when held stable for more than 3 seconds or you can click the Edit Manually box and enter in the desired shaft speed.

The balancing is ready to begin. When ready press the green “Initial Run” button in the software. This step takes an initial measurement of the shaft.
Accelerate to the required speed. The RPM graph will be green when in the specified RPM range. Data will only be gathered while the RPM is in the specified range. As data is collected the % Completed bar will fill. When complete, place the vehicle in neutral and turn off the engine.

4.4.2.1.2 Calibration Run 1

Place 4.5 grams of weight at location 1 by stacking 3 of the balancing weights (1.5 g each). Click the green Calibration Run 1 button to proceed. Note that the weights can be mounted to the front or rear of the flange.
Accelerate to required speed until the % complete bar reaches 100%. When complete, place the vehicle in neutral and turn off the engine.

4.4.2.1.3 Calibration Run 2

Remove the balancing weights from position 1 and install them at position 3. Click the green Calibration Run 2 button to proceed.
Accelerate to required speed until the % complete bar reaches 100%. When complete, place the vehicle in neutral and turn off the engine.

4.4.2.4 Calibration Run 3

Remove the balancing weights from position 3 and move them to position 5. Click on the green Calibration Run 3 button to proceed.
Accelerate to required speed until the % complete bar reaches 100%. When complete, place the vehicle in neutral and turn off the engine.

4.4.2.1.5 Balance the shaft

Remove the balancing washers from position 5. Install the balancing washers at the location(s) directed by the software to balance the shaft. Click the green Verification button to continue.
Accelerate to required speed until the % complete bar reaches 100%. When complete, place the vehicle in neutral and turn off the engine.

4.4.2.1.6 Verification run

The final imbalance will be displayed by the software. If the imbalance exceeds the minimum requirement the software will suggest removing the rear tires (ensure the rotors or drums are secured to the hub) and restarting the test.

If restarting the test, remove all the balance weights. The “Initial Run” button can be clicked to restart the test or the “Balancing” button can be clicked to go back through the setup wizard.
4.4.2.2 Hose Clamp Trial Balance Wizard

The Hose Clamp wizard will run you through the various steps required to complete your test. These will steps will cover:

- Connections to the scope
- Mounting the accelerometer to the vehicle
- Fit the magnetic mount and optical sensor (if required) in order to read the propshaft rotation speed
- Entry of required technical data

4.4.2.2.1 Initial Run

Before you begin

- Insure the vehicle is properly supported (refer to service information)
- Remove rocks and debris from the tires
- Ensure all the leads are clear of rotating components
- Disable ABS and Traction control if equipped
- Turn off the AC and other accessories

Find a suitable shaft speed. Run the engine with the transmission in high gear to highway speed (65-70 mph typical). The software will capture the RPM when held stable for more than 3 seconds or you can click the Edit Manually box and enter in the desired shaft speed.

Place the first clamp on the rear of the shaft. Clearly mark its location – this is going to be the reference point for all other measurements. Label the mark as “0 mm”.

Measure the distance specified by the software to place the second clamp. Place the second clamp next to the first.

When ready press the green "Initial Run" button in the software.
Accelerate to the required speed. The RPM graph will be green when in the specified RPM range. Data will only be gathered while the RPM is in the specified range. As data is collected the % Completed bar will fill.

4.4.2.2.2 Calibration Run 1

Once the % Completed bar is filled the software will direct you to place both clamps at the 0 mm mark and to click on the green Calibration button when ready.
Accelerate to required speed.
Measuring in the direction of forward shaft rotation, measure and mark the point indicated by the software. Place both clamps and press the green Calibration button when ready.

Accelerate to required speed.
4.4.2.2.4 Calibration Run 3

Measure the distance specified from the 0 mm mark and place both clamps.

Accelerate to required speed.
4.4.2.2.5 Balance the shaft

Measure and mark the locations directed by the software and place the clamps.

Accelerate to required speed.
4.4.2.6 Verification run

The final imbalance will be displayed by the software. If the imbalance exceeds the minimum requirement the software will suggest removing the rear tires (ensure the rotors or drums are secured to the hub) and restarting the test.

If attaching a single weight is desired the hose clamps can be removed and replaced with a single weight as indicated by the software at the location of the blue arrow.

4.4.3 Options

This menu is found under Tools in the main menu bar when the Propshaft Balancing test is selected.

Choosing Options reveals the Propshaft Balancing Wizards selection screen.
4.5 NVH

NVH (Noise, Vibration and Harshness) is the study of unwanted movements and sounds generated by a vehicle. The PicoDiagnostics NVH software can analyze vibrations and help to diagnose NVH problems. All you need is a PicoScope Automotive oscilloscope, the PicoDiagnostics NVH kit and a software license key (available from Pico Technology support).

4.5.1 Equipment

**PicoScope oscilloscope:** receives signals from the microphone or accelerometer, or other vehicle component, converts them to digital data and feeds this to the computer for analysis.

**Accelerometer:** a vibration-sensing device connected to the PicoScope oscilloscope. It must be attached rigidly to a vibrating part of the vehicle using the magnet or mounting screw supplied.

**NVH interface:** allows microphones and accelerometers to be connected to the PicoScope oscilloscope. The NVH interface supplies power to the amplifier while transmitting vibration and sound signals to the oscilloscope.

**Optical sensor interface:** allows optical sensor to be connected to the PicoScope oscilloscope. The optical sensor interface supplies power to the optical sensor while transmitting data signals to the oscilloscope.

**Microphone:** a sound-sensing device connected to the PicoScope oscilloscope. It can be used to pick up noise inside the vehicle cabin, or from outside the vehicle in cases such as brake squeal.

4.5.2 Terminology

NVH is a specialist area of engineering that has its own terminology. Some of these terms are from signal processing mathematics and might not be familiar to technicians without NVH training.

**Amplitude:** the strength of a vibration or the loudness of a sound. On the graphs produced by the PicoDiagnostics NVH software, higher peaks indicate larger amplitudes.

**Frequency:** the speed at which a component rotates or vibrates. The most common measures of frequency are RPM (revolutions per minute), CPM (cycles per minute) and hertz (vibrations per second). A rotation rate of 60 times per minute (60 RPM or 60 CPM) is equal to one rotation per second or 1 hertz (abbreviated to 1 Hz). The graphs produced by the PicoDiagnostics software show vibrations arranged by frequency. Lower frequencies are always shown on the left, higher frequencies on the right.

**Fundamental:** see Harmonic.

**Harmonic:** when a component rotates or vibrates at a certain frequency, it can also cause vibrations at higher frequencies—two, three or more times its own frequency. The frequency of the original rotation or vibration is called the fundamental frequency, and the faster frequencies are called harmonics. Twice the fundamental frequency is called the second harmonic, three times is called the third harmonic, and so on.

**Order:** another word used to describe harmonics. A vibration at twice the speed of a rotating component is called a second-order vibration; three times the speed is a third-order vibration, and so on.
**Resonance**: a marked increase in the transfer of energy from one vibrating component to another at a particular frequency. For example, if a body panel is normally quiet but vibrates strongly at a particular engine RPM, resonance is the likely cause. The body panel is said to 'resonate' at that RPM.

**Spectrum**: a graph that shows sounds and vibrations. The horizontal position of the vibration shows its frequency: lower frequencies are on the left, higher on the right. The vertical position of the vibration shows its amplitude: higher amplitudes (stronger vibrations) are at the top, lower at the bottom.

4.5.3 Connecting the PicoScope and sensor

a) Connect the oscilloscope to your computer using the blue USB cable supplied with the oscilloscope.

b) Plug your chosen sensor into the NVH or Optical sensor interface.

Note: When using the TA143 or TA183 accelerometer for NVH measurements observe the handling instructions supplied with the accelerometer and magnet.

c) Connect the NVH or Optical sensor interface box to the PicoScope oscilloscope channel referred to from the software setup tab.

4.5.4 Running the PicoDiagnostics software

Click the **PicoDiagnostics** icon on your Windows desktop:

or run **PicoDiagnostics** from the Windows Start menu.

4.5.5 Selecting the NVH test

Click **NVH**:
4.5.6 NVH Wizard

Once the NVH test has been selected you will be presented with the Setup tab and NVH Wizard screen.

Within the Wizard there are four options:

- **Start a new test**: This option guides you through the various steps in order to correctly setup the NVH test parameters.

- **Load a saved test**: This option opens the familiar Windows Open dialog box. Navigate to your chosen file and choose *Open* to see your test data on the Record and Analyze tab.

- **Skip the wizard process. Use the last settings I entered**: This option takes you to the final Wizard screen. Clicking *Finish* shows the Record and Analyze tab (no data), with previously used settings applied.

- **Cancel**: Canceling the NVH Wizard returns you to the Setup tab for NVH Manual setup.
4.5.7 NVH Setup page

If the NVH Wizard has been canceled but an NVH test is required, the Wizard can be restarted by clicking the NVH button, or by choosing NVH from the Tests menu. As an alternative to using the Wizard, you can enter settings manually in the Setup page as follows:

4.5.7.1 RPM Signal

An RPM Signal source needs to be selected. Choose either:

- J2534 / MDI approved Scan Tool
- Square Wave / Tach
- Static RPM

**J2534 / MDI approved Scan Tool**

a) Plug the MDI scan tool into a USB port on the computer.

b) Check that the program recognizes the scan tool.

c) Plug the J2534/scan tool into the vehicle’s 16-pin (OBD-II or EOBD) diagnostic socket.

d) Check that the RPM signal is being received:
**Square Wave / Tach**

For this option connect any signal proportional to RPM, such as camshaft, to either Channel A of a 2-Channel automotive scope or Channel D of a 4-Channel automotive scope.

**Static RPM**

If the vehicle will remain at a static RPM during the test, enter the RPM value here.

4.5.7.2 **Vibration Signal**

The *Vibration Signal* settings also require confirmation.

**Mode** informs the software of the equipment you have connected to the oscilloscope. The available choices are **Single Channel, 3-axis, 3-axis plus Single Channel**, or **Multiple Sensors**.

**Single Channel**

This mode is for use with a single-axis accelerometer, and when using a single channel of a 3-axis accelerometer.

**Box** refers to which NVH interface you have connected to the PicoScope oscilloscope (refer to rear label).

**Sensor** is used to select the type of sensor attached to the NVH interface.

**Orientation**

While this setting makes no difference to the way in which the software records data, it is a useful feature for stating the orientation in which the accelerometer is placed during the test.

**Location**

Indicates where the sensor will be placed. If the vibration can be felt when sat in the vehicle, **Passenger compartment** would be selected. If the software then identifies the problem vibration as originating from the engine, the accelerometer can be moved into the engine bay, and this setting adjusted to **Engine compartment**.
Notes are used to record specific information about the test. The notes will appear as a tooltip while viewing the bar graph data and hovering over each graph with the mouse pointer. Each interface box has its own notes area, and each note entry field is limited to 1000 characters.

3-axis

The 3-axis option from the Mode selection alters the user interface slightly, revealing additional setup options:

Box as above.

Sensor as above.

Channel A (X) If checked, this instructs the program to record signal data for the X axis.

Channel B (Y) If checked, this instructs the program to record signal data for the Y axis.

Channel C (Z) If checked, this instructs the program to record signal data for the Z axis.

Note: The Z axis is unavailable if the NVH Interface has been connected to a 2-channel automotive scope.

Location as above.

Notes as above.
3-axis plus Single Channel

**Note:** The 3-axis plus Single Channel mode is unavailable if the NVH Interface has been connected to a 2-channel automotive scope.

The 3-axis plus Single Channel option from the **Mode** selection alters the user interface slightly, revealing additional setup options:

- **Box** as above.
- **Sensor** as above.
- **Channel A** (X) If checked, this instructs the program to record signal data for the X (Fore/aft) axis.
- **Channel B** (Y) If checked, this instructs the program to record signal data for the Y (Vertical) axis.
- **Channel C** (Z) If checked, this instructs the program to record signal data for the Z (Lateral) axis.
- **Location** as above.
- **Orientation** as above.
- **Notes** as above.
**Multiple Sensors**

The Multiple Sensors option from the Mode selection alters the user interface slightly, revealing additional setup options. You must inform the software of how many interface boxes you have attached to your PicoScope oscilloscope, and specify the type of sensor attached to each. The number of interfaces connected can be adjusted in the box next to the Mode option, and can have the value of 2, 3 or 4.

![Multiple Sensors setup interface](image)

**Signal quality check**

The Vibration Signal on the Setup tab includes a Signal Quality bar. Here you are able to check the software is registering the signal from the accelerometer. Tap the accelerometer with your finger and check that a pulse is shown on the signal bar:

**No vibration:**

![No vibration setup interface](image)

**Vibration detected:**

![Vibration detected setup interface](image)
4.5.7.3 Signal Options

This setting is used to set the desired capture time, which can be from 50 to 500 seconds.

This box is not displayed on the setup screen by default. You can change this by ticking the **Enable Advanced Options** box in the Advanced Options dialog.

4.5.8 NVH Vehicle Information page

Under the Vehicle Information tab, select the vehicle's drivetrain configuration, and enter the make, model and year of manufacture.

There is an added feature for managing and using Parameter IDs (PIDs), click the **Configure PIDs** button to use it.

4.5.8.1 Advanced button

Select the **Advanced** button to enter more specific vehicle details.
4.5.8.2 Configure PIDs button

PIDs are codes that are used to request data from a vehicle for diagnostics. The SAE standard J/1979 defines several PIDs, but many more PIDs are specified by the respective vehicle manufacturer's. Typically, technicians use PIDs with a scan tool connected to the vehicle's OBD-II connector.

The PID is sent to the vehicle's controller-area network, a device on the bus recognizes the PID and reports the value for it back to the bus, from which it is sent to the scan tool and displayed to the technician.

**Note:** You can only view the values from the PIDs in the Time Domain view on the record and analyze tab.

The Configure PIDs dialog includes two lists, along with several functions. The first list is called **Available PID Library.** This list contains PIDs that you can select to capture, edit, delete or export. The second list is the **Current Capturing PIDs,** which shows you the PIDs in use and their current values.

When you select one or more PIDs from the **Available PID Library** list you have the option to click on the **Start Capturing** button. By clicking this button you move the selected PIDs to the **Current Capturing PIDs** list and will be able to read the values.
If you want to remove PIDs from the Current Capturing PIDs list you select them and click the now active Stop Capturing button, which will move them back to the library list.

You can export PIDs as .pdpid files by selecting one or more PIDs from the Available PID Library list and clicking on Export. You will then be asked if you want to export only the selected files or the entire Library, before you select the directory to save to.

You can import exported .pdpid files to add to the Available PID Library list.

You can create new PIDs by clicking the Create button. You will then see the Create PID dialog box. Enter the PID (hex) along with its description formula and unit. Click OK to create the PID.
4.5.9 NVH Record and Analyze page

To begin the test:

- Click the Start button: 

The time chart at the bottom of the screen will show the signal from the accelerometer. Start the engine.

Note: If the vibration can be felt while the vehicle is stationary then the test can be done in the workshop. Otherwise, a road test will be necessary.

Run the road test or workshop test while **PicoDiagnostics** captures data from the vehicle. You will see data appearing in the time chart at the bottom of the window. This chart also shows RPM, road speed and gear selection for the duration of the test.

![Time Chart Example]

When the test is finished, click the Stop button: 

To reset the current capture and clear any recorded data while retaining the test settings, click the Reset Capture button: .

4.5.10 Viewing the results

For the clearest results, select the region of the test where the vibration was at its strongest. Do this by dragging the mouse over the time chart from the beginning to the end of the region of interest.

![Time Chart Example]

You can now view the results in a number of ways. Clicking one of the view buttons will display the chosen view.

| Frequency | 3D Frequency | Road Speed | RPM Order | Bar Graph | Time Domain |

4.5.10.1 Frequency graph

The frequency graph displays the relevant spectrum for the sensor in use. (0-200 Hz for an accelerometer)

In the example below, the main vibration detected is clearly identified as an E2 (second order engine vibration) An E2 vibration is quite normal with a 4 cylinder 4 stroke engine, as the crankshaft is subjected to two firing events every revolution. (Twice the fundamental frequency of the engine - E1) The accelerometer will detect the level of E2 vibration and display the amplitude in “mg” units in the frequency graph. Each individual axis of a 3-axis accelerometer can be displayed by selecting **Display Mode** and **Single by**
right-clicking on the Frequency graph. Each axis is represented by a different color and its respective amplitude indicated along the Y-axis.

An excessive amount of E2 could indicate a problem with engine mounts or the "contact" between the engine and the chassis.

4.5.10.2 RPM order graph

By selecting **RPM Order** you will see the Frequency Display converted to indicate vibration levels relevant to engine speed/frequency. The **RPM Order** display is now scaled in multiples of the fundamental engine speed (E1) allowing the NVH software to track and display engine vibration orders in a fixed position regardless of engine speed. This is particularly useful should you wish to monitor engine vibration orders at varying engine speeds and loads. The images below highlight the effects on a second order engine vibration from a four stroke four cylinder engine under acceleration (Figure 1) deceleration (Figure 2) and cruising (Figure 3).
Figure 3

A high second order engine vibration is characteristic of a four stroke four cylinder engine, given the crankshaft is subjected to 2 x combustion events or shocks per engine revolution (E2). During acceleration (Figure 1: 3146 rpm) the crankshaft loading will increase due to driver demand. (High E2) Under deceleration the opposite will occur (Figure 2: 1725 rpm) where fuel is cut during over-run and crankshaft combustion load is removed. (Minimal E2) When cruising (Figure 3: 1748 rpm), fuelling and combustion are present but with reduced load upon the crankshaft (Low E2)

Referring to all the images of the RPM Order above, the position of E1 and E2 markers remain fixed throughout the entire engine speed / frequency range, and the scale indicates partial, or multiples of, engine vibration orders assisting with clear identification of offending engine vibrations.
4.5.10.3 Road speed graph

In this graph, frequencies are scaled to road speed, so wheel and axle-related harmonics appear at fixed positions regardless of road speed. This makes it easier to spot propshaft and wheel-related vibrations during a road test.
4.5.10.4 Bar graph

This view lists all the selected vibration harmonics and shows their values in real time. Below, Unknown (U) vibration peaks have been enabled under Add Vibration.

With **3-axis plus single channel** and **Multiple sensors** you have the option of adding a microphone as a sensor. When you add a microphone, the Bar Graph view in Record and Analyze will change to show the measurement dB as well as a different color on the bar compared to the vibration bars.

**Single Channel**

![Single Channel Diagram](image1)

**3-axis (in default view)**

![3-axis Diagram](image2)
3-axis (in Channels view)

3-axis plus Single channel (in Channels view)
3-axis plus single channel (in default view)

4.5.10.5 3D frequency graph

The 3D frequency graph creates a record of how the vibration spectrum changes over time during a test drive. Selected vibrations are plotted as colored path allowing users to monitor the change in frequency of a specific vibration over time. Such a feature will assist with the detection and measurement of resonance that is present for a brief moment in time when a forced vibration matches the natural frequency of a component (for instance the exhaust resonance at a specific engine RPM). The axes can be dragged to change the vertical and horizontal scales along with the viewing angles.
4.5.10.6  Time Domain

Time domain is a real time feature you can use to measure harshness, such as knocks, creaks and squeaks. Noises and harshness like these are annoying but are only present for a very short period of time, with insufficient energy to be transferred to and displayed in the Frequency display (FFT) of the NVH user interface. The time domain feature will capture and display the momentary amplitude of these noises.

Events (e.g. pothole strikes) are captured in the signal history as it displays the input of the attached microphone or accelerometer live (relative to time). These events are not transferred for display in the FFT as it requires a minimum of 2.5 seconds of continual disturbance in order to process the event.

Until now, symptoms like these would be reserved for listening devices, letting the technician listen to the intensity of noises delivered to a headset from microphones placed around the offending area of the vehicle. The results, however, would be subjective and open to misinterpretation.

For instance:

Given the vehicle chassis is a single structure, any momentary noise is dissipated throughout the chassis where it can be detected at strategic points about the chassis by accelerometers or microphones.

The accelerometer/mic adjacent to the knock will detect the highest amplitude and the accelerometer/Mic furthest away from the knock will detect the event but at a reduced amplitude.

The Time Domain display gives the technician the ability to detect the source of a momentary knock, squeak, creak or click, despite their presence only being felt/heard for just a split second.
Above: Note that the Time Domain view is the only view that displays the data from capturing PIDs.

4.5.10.7 Graph features

**General features**

Drag left and right on the graph to position the **order** markers. The markers are automatically positioned at the **fundamental** frequency and its **harmonics**.

Drag the vertical axis up and down to change the vertical scale.

Drag the box at the bottom of each frequency ruler to move the ruler.
Right-click on any graph to reveal the context menu:

- **Scale To Fit.** Only available in Time Domain.
- **Link Scales.** Only available in Time Domain.
- **Display PID Configuration.** When this is enabled the PID will be displayed in with the PID ID (hex) and the formula.
- **Auto Scale.** This will enlarge or reduce the vertical scale to make the signal fit on the graph.
- **Reset the scale.** Resets the scale view to default.
- **Reference Waveforms.** Available in Frequency view, use this function to add previously saved data as a reference.
- **Channels In View.** Lets you to display/hide individual channels of data from the scope.
- **PIDs In View.** Available in Time Domain view. Lets you display/hide individual PIDs from the screen.

Display Mode. See below:

- **Vector Sum.** Only available when 3-axis Mode or 3-axis plus single channel has been selected. Displays the magnitude of the vector sum of all three axes.
- **Single.** Displays the amplitude of each of the selected Channels in View individually.
- **Peak.** Shows the highest amplitude of the selected Channels in View.
- **Average.** Averages the amplitude of all the selected Channels in View.

Only available when 3-axis Mode or 3-axis plus single channel has been selected, these buttons switch between Vector Sum and Single display modes (see above).

Clicking this accesses the Customer Details information screen.

Clicking this button will preview the report ready for printing.

Click any vibration marker for more information.
Use this button to show or hide specific vibration orders on each graph.

Right-click on the recorded data at any time to reveal the context menu:

**Place Signal Marker.** This will place a signal marker at the point the right-click was made, regardless of the time delay between the right and left mouse button clicks.

**Remove Marker.** Right-click on a previously placed *Signal Marker* to reveal the context menu. This option will remove the marker at the point the right-click was made.

**Export Selected Region To CSV.** This will save a CSV file containing all the vibration data that is currently within the selected region of recorded data.

**Export Selected Region to WAV.** This will save a WAV file containing all the audio data that is currently within the selected region of recorded data.

These buttons are used to:

**Place Signal Marker.** This button is only available while recording data, and is used to add a signal marker at the currently recorded data point.

**Scroll through signal markers.** These buttons are used to scroll backwards or forwards through placed *Signal Markers*. Only available once recording has been completed.

**Vibration order markers**

In the various frequency graphs, vibration orders are marked with labels such as “T1” and “E2”. The letter indicates the type of vibration:

- **E** = Engine
- **T** = Tires
- **P** = Propshaft
- **U** = Unknown
- **AP** = AC pump pulley
- **A** = Alternator pulley
- **PS** = Power steering pulley
- **W** = Water pump pulley

The number is the order of vibration. For example, “E2” is the second-order engine-related vibration.

Click on any marker in *PicoDiagnostics* for more information.
4.5.11 NVH Options
Location: Options on the menu bar

Note: some of the commands shown below might not be available unless the Enable Advanced Options box is ticked in the Advanced Options dialog.

Save Settings: PicoDiagnostics will remember any changes you made to the program settings and use them next time you run the program.

Advanced Options: Opens the Advanced Options dialog, which controls the signal processing algorithms used by PicoDiagnostics.

Calibrate: Opens the Calibration Wizard. Only available for single and 3-axis mode.

Load Audio Files: Opens the Load Audio dialog for using a WAV format audio file instead of using the microphone.

Function Generator: Opens the Function Generator dialog.
4.5.12 NVH Advanced Options

Location: **Options** on menu bar, then **Advanced Options**.

The tabs contain various options related to frequency spectrum calculations. While these are detailed below, we suggest you do not adjust them unless recommended to do so by your Technical Support department.

**Graph**

![Advanced Options window](image)

- **Maximum frequency of interest**: Maximum frequency that will be displayed with the FFT views.
- **Frequency Units**: Adjusts the unit of measure along the X axis in the FFT views (RPM/Hz/CPM).
- **SPL Weighting**: Allows you to adjust the weighting for Sound pressure level (SPL). The available options are: dB(A), dB(B), dB(C), and dB(SPL).
- **Harmonic Marker Count**: Lets you choose the number of harmonic markers to use on the capture.
- **G Scaling**: Lets you choose the scale. The dBg is a logarithmic scale while g is a linear scale.
### FFT

**Windowing:**
Lets you select one of the standard window functions for spectrum analysis. The available options are: **Hann**, **Rectangular**, and **Flat-top**.

**FFT Bin Count:**
Adjust points of FFT sacrificing processing time.

**Responsiveness**
Allows you to adjust the length of the scan time. Reducing the scan time reduces resolution of frequency in the FFT.

### Filter

**Low pass filter:**
Allows any frequency below the set threshold to be detected.

**High pass filter:**
Allows any frequency above the set threshold to be detected.

**Band Pass:**
When enabled allows frequencies between the Low pass and High pass range to be detected.

**Band Stop:**
When enabled allows frequencies outside of the Low pass and High pass range to be detected.
**Features**

Enable Advanced Features: Some commands under the main Options menu are hidden unless this box is ticked.

Enable Wizard: By default this option is enabled. To stop the NVH Wizard from appearing uncheck this box.

Calculate Road Speed: Enable this to calculate the road speed through the gear ratios in order to derive the tire and propshaft vibrations. This can be used instead of gaining the vehicle speed via the OBD port. 
*Note: If a Square Wave/Tach is used for RPM signal, this option is on by default.*

Enable OBD Logging: Adds additional information to the trace file (for Technical Support).
4.5.13 Load Audio dialog

Location: **Options > Load Audio Files** on the menu bar

This dialog is only available when the **Enable Advanced Options** box is ticked in the **Advanced Options dialog**.

By using this dialog you can analyze previously recorded audio, for example of vehicle noise recorded by a customer. The file must be in WAV format.

1. Click **Load** and locate the audio file.
2. Verify that the **Sound Properties** are correctly shown.
3. If desired, click **Play** to listen to the file.
4. To convert the file for vibration analysis in **PicoDiagnostics**, click **Create Signal**.
4.5.14 Function Generator

The inbuilt function generator can generate sounds using your laptop to stimulate resonance, causing an object to vibrate with a greater amplitude at its specific natural frequency. This means that the technicians can listen to audio played back at specific frequencies and match it to sounds present in the vehicle.

The feature can be manipulated to playback audio through the vehicle’s In Car Entertainment system (ICE) via the PC headphone socket, streamed from the PC via Bluetooth, or FM modulator if the vehicle does not have Aux or Bluetooth.

This is a very useful feature when customers complain about interior rattles. They will often have difficulty describing the sound or pinpointing the origin. If you playback variable low frequencies via the ICE with the Function generator, and increase the volume, you can generate rattles inside the cabin that can be confirmed by the customer and help the technician find the origin. All safely done in a parked car.

Source

There are several different sources to choose between: Fixed frequency, T1, T2, T3, E1, E2, P1 and P2

You can output fixed frequencies through the speakers and compare them to the vibrations heard during a road test, or you can select other frequency sources to output to the strobe light hardware to identify faulty components.

Frequency

Number of Hz to use when creating the playback sound. Use the arrow buttons to adjust it up or down.
**Wave type**

Sine wave is used to replicate frequency vibrations through the speakers. Square wave is used for controlling the Strobe light function.

**Hz bar**

You can also adjust the number of Hz by dragging the blue button right or left on the bar. This is useful if you do not know the number of Hz, as you can drag this back and forth while playing the sound to hear the difference and use for matching.

**Mute button**

By clicking this button you can toggle the sound on and off.
Sweep mode
By ticking this box you enable sweep mode. In sweep mode you can sweep up or down between the start frequency and the end frequency at a specified sweep time.

Sweep Down
Makes the function generator sweep from the high frequency to the low frequency.

Sweep up
Makes the function generator sweep from the low frequency to the high frequency.

Pause
Temporarily stops the sweep.

Resume
Starts the sweep again from where you paused it.

Start frequency
The lowest number of Hz that you want to sweep to/from

End frequency
The highest number of Hz that you want to sweep to/from

Sweep time
The time you want to do the sweep in.
Index

3
3-axis 44
3-axis plus single channel 44
3D frequency graph 58

A
Accelerometer 40
Access 3
Add vibration 60
Amplitude 40

B
Bar graph 56
Battery test 20, 22, 24
  Connections 21
  Options 23
  Results 25

C
Calculate Road Speed 64
Compression test 15, 16, 17
  Conditions 15
  Connections 16
  Failed 19
  Options 16
Configure PIDs 48
Copyright 3
Customer details 60
Customer details form 6
Cylinder balance 9, 9, 11
  controls 12
  Failed 14
  Options 11
Cylinder variation 12

D
Details dialog 6
Display mode 60
Display PIDs data 59

E
Enable Advanced Features 64
Enable OBD Logging 64
Exit command 4

Export 60

F
Filter options 64
Fitness for purpose 3
Frequency 40
Frequency graph 51
Function generator 68
Fundamental 40

H
Harmonic 40
Help menu 8

L
Legal statement 3
Liability 3
Licence agreement 3
Load Audio dialog 67
Load command 4

M
Menu bar 4
Microphone 40
Misfires 12
Mission-critical applications 3
Multiple sensors 44

N
Notes form 6
NVH advanced options 64
NVH graph features 60
NVH interface 40
NVH options 63
NVH results viewer 51

O
Order 40

P
PIDs 48
PIDs in view 60
Preferences command 4
Print report 60
Propshaft Balancing 26
Index

R
Record and analyze  51
Resonance       40
Road speed graph  55
RPM order graph  52
RPM signal     43

S
Save command   4
Scan tool      43
Signal graph   13
Signal markers 60
Signal options 48
Signal quality check 44
Single channel 44
Spectrum       40
Square wave    43
Static RPM     43
Support        3

T
Tach           43
Tests menu     8
Time Domain    59
Trademarks     3

U
Upgrades       3
Usage          3
User details   5

V
Vehicle details form  6
Vehicle information 48
Vibration order markers  60
Vibration signal   44
View menu        5
Viewing the result 51
Viruses         3